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1. PREAMBULE 

1.1. A propos 

Je suis Jérémy Laplaine et suis passionné par Excel. C’est donc à travers mes blogs que j’ai voulu 

partager ma passion, d’abord avec www.modelisation-excel.com et à présent avec www.cooking-

excel.com.  

Mon expérience m’a permis d’acquérir au fil des années des compétences en systèmes 

d’informations (Analyste-programmeur puis chef de projet), en Gestion d’entreprise (gérant de 

plusieurs sociétés) et en Finance (d’abord sur SAP, puis sur la Trésorerie de groupe).  

Bien entendu, tout au long de ces années, Excel m’a accompagné. Ces expériences m’ont permis 

d’appréhender et de bien connaître certains outils, d’Excel à la suite Power BI (Power Pivot, Power 

Query, Power View et Power BI Desktop), en passant par le langage SQL et SAP. 

 

D’un point de vue plus fonctionnel, j’ai également beaucoup travaillé dans la finance d’entreprise qui 

m’a conduite notamment à réaliser des modèles financiers dans Excel. 

 

 

 

 

J’ai souhaité réalisé ce livre afin de rendre plus accessibles de nombreuses astuces Excel à travers un 

cas concret et complet applicable directement en entreprise. 

 

http://www.cooking-excel.com/
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1.2. Introduction 

 

L’objectif de ce livre est de vous fournir un maximum de trucs et astuces pour construire vos tableaux 

de bord à travers la réalisation d’un cas complet façon www.cooking-excel. 

Pour réaliser le tutoriel, il vous faut télécharger auparavant le fichier Excel des données: 

Fichier_De_Donnees.xlsx 

Il ne s’agit pas de l’exhaustivité des techniques pour réaliser des tableaux de bord mais un ensemble 

de techniques qui seront réutilisables. En suivant pas à pas le tutoriel, vous vous familiariserez avec 

les graphiques et surtout vous acquerrez la logique pour la réalisation de vos propres tableaux de 

bord. 

Le tableau de bord complet est divisé en 4 parties avec pour chacune les ingrédients à utiliser, la 

difficulté ainsi que la durée de réalisation. 

A la fin de ce livre, vous trouverez un récapitulatif des 71 astuces. 

Je vous conseille fortement de suivre les étapes dans l’ordre mais une fois que vous aurez terminé le 

cas, vous pourrez vous y référer afin de retrouver une astuce ou une étape en particulier.  

http://www.cooking-excel.com/
http://www.cooking-excel/
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1.3. Nomenclature 

 

Au début de chaque nouvelle étape, vous trouverez une partie comprenant les éléments suivants : 

Difficulté :   

Ingrédients : Tableaux Croisés Dynamiques (TCD), INDEX, EQUIV, SIERREUR, SI 

Durée : 15 minutes 

 

Difficulté 

Facile 

 Intermédiaire 

  Avancé 
 

 Ingrédients 
Comprend la liste des tout ce 
qui va être utilisé lors de 
l’étape : les fonctionnalités, les 
fonctions, 
 

 Durée 
Durée approximative de l’étape. 
Bien sûr, cela dépend de chacun. Je 
suis parti du postulat que les 
lecteurs ont déjà des bases sur 
Excel. 

 
Astuce 

 

 

Les couleurs 

A RETENIR 

 

Avec EXCEL 2010 

 

Avec EXCEL 2013 ou supérieur 

 

Avec EXCEL 2016 

 

 

 

RUBAN : Accueil > Coller 
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(Feuille : Factures, Cellule : A3) : Se positionner sur la feuille nommée « Factures », sur la cellule A3. 

(Feuille : Factures, Plage : A3:B5) : Sélectionner les cellules suivantes dans la feuille nommée 

« Factures » : 
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2. Les graphiques dans Excel 
 

Avant de commencer, il est important de vous familiariser avec les graphiques Excel si ce n’est déjà 

fait. Je vous propose dans un premier temps de vous détailler les éléments d’un graphique, tels que 

les légendes, les axes par exemple.  

Dans un second temps, je présenterai un petit schéma que j’ai trouvé très intéressant permettant de 

vous aiguiller dans le choix d’un graphique. Il est à noter qu’Excel propose des graphiques mais avec 

des astuces, des superpositions, et un peu d’imagination, il est possible d’en créer de nouveau. 

N’avez-vous jamais vu par exemple le thermomètre ou le compteur de vitesse ou bien encore le 

diagramme de Gantt ? 

 

 

 
 

 
 

 

Enfin, je terminerai par des conseils précieux à travers de bonnes pratiques pour la conception de 

tableaux de bord. 

Pour réaliser un graphique thermomètre. 
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2.1. Eléments d’un graphique 

 

Un graphique comporte de nombreux éléments. Certains d’entre eux sont affichés par défaut, 

d’autres peuvent être ajoutés en fonction des besoins. Vous pouvez modifier l’affichage des 

éléments d’un graphique en les déplaçant sur d’autres emplacements dans le graphique, en les 

redimensionnant ou en modifiant la mise en forme. Vous pouvez également supprimer les éléments 

de graphique que vous ne souhaitez pas afficher. 

 
Astuce 1 – Elements d’un graphique 

 

1. L’aire graphique du graphique ; 

2. L’aire de traçage du graphique ; 

3. Les points de données des séries de données tracées dans le graphique ; 

4. Les axes horizontaux (catégorie) et verticaux (valeur) le long desquels les données sont 

tracées dans le graphique ; 

5. La légende du graphique ; 

6. Un titre de graphique et d’axes que vous pouvez utiliser dans le graphique ; 

7. Une étiquette de données que vous pouvez utiliser pour identifier les détails d’un point de 

données dans une série de données. 
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2.2. Comment choisir ?  Quelques suggestions 
 

 
Astuce 2 – Comment choisir un graphique ? 

Il n’est pas toujours aisé de trouver le graphique qui répond à vos besoins. D’ailleurs, régulièrement 

j’ai constaté que le choix n’était pas toujours opportun. C’est pourquoi je vous propose ce petit 

schéma que j’ai récupéré et qui me sert régulièrement.  
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3. Bonnes pratiques 

3.1. L’essentiel 
 

 
Astuce 3 – Bonnes pratiques: l’essentiel 

1. A chaque graphique, il faut associer un tableau de données. Un graphique est toujours basé sur 

une ou plusieurs série(s) de données.  

2. Un tableau de bord doit tenir sur une page (pour impressions ou présentation PPT) 

3. La principale qualité d’un tableau de bord est sa clarté. Chaque personne qui regarde le TDB doit 

comprendre rapidement de quoi il s’agit et à quoi correspond chaque partie. Il est également 

très important d’afficher les unités (€, K€, $, quantités, …) 

4. Un Tableau de bord (TDB) doit avant tout répondre aux objectifs définis.  Il est important de ne 

pas surcharger un TDB. Aussi, il faut bien définir quels sont les indicateurs nécessaires. Peut-on 

également les mettre sur un seul TDB ? Y a-t-il une cohérence ? 

5. Il est nécessaire d’avoir un équilibre graphiques / chiffres car la perception de chacun est 

différente. Pour certains un graphique parle beaucoup plus qu’un tableau de données. Pour 

d’autres, c’est le contraire. Il est donc nécessaire d’avoir un équilibre entre ces deux types 

d’informations. 

6. Avoir un accès rapide à une feuille des Inputs. Cela permet lors d’une réunion, de modifier des 

données rapidement et de voir l’impact sur le tableau de bord (« What if ? » - « Que se passe-t-il 

si … ? ») 

7. Il est important de réserver un onglet avec les explications nécessaires à l’utilisation du Tableau 

de Bord, comprenant également des explications relatives à l’origine des données. 

 

3.2. Less is More  
        

 
Astuce 4 – Bonnes pratiques: Less is more 

8. Ce n'est pas parce qu'Excel permet d'ajouter de nombreux formats ou des effets 3D qu'il faut 

tous les utiliser. Rester simple.         

9. Si vous souhaitez faire passer plusieurs messages, utilisez plusieurs graphiques.   

10. Si vous avez plusieurs graphiques avec les mêmes étiquettes de données, alignez les dans le 

même graphique.     

11. Ce n'est pas parce que vous avez des données qu'il faut absolument les mettre dans votre 

tableau de bord. Assurez-vous que c'est en rapport avec l'objectif et que cela aide à 

l'interprétation globale.     
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4. Présentation du cas 
 
Le tableau de bord que vous allez réaliser a été conçu spécialement pour vous. Il a un objectif 
pédagogique qui consiste à se familiariser avec les possibilités d’Excel pour la réalisation de tableaux 
de bord.  
 
Les données étant relatives à des factures et des clients, il parle à tout le monde et de nombreuses 
parties pourront être reproduites pour vos propres besoins, avec les modifications nécessaires. 
 
Dans le chapitre précédent, je vous parlais des bonnes pratiques. Ce Tableau de bord ne répond pas 
à 100% de ces pratiques car je souhaitais avant tout qu’il puisse vous proposer de nombreuses 
astuces. 
 

4.1. Les données 
 
Vous trouverez l’ensemble des données à travers deux tableaux Excel : 

 Factures 

 Clients 
 
Dans l’onglet Factures, vous trouverez donc le premier tableau comprenant notamment la colonne 
« Code Client » qui est reprise dans le second tableau. Il s’agit de la clé permettant de retrouver un 
client. 
 
Les dates relatives au tableau Factures sont sur deux années : l’année en cours (spécifiée sur l’onglet 
préparation en fonction de la date du jour) et l’année précédente ; les valeurs se mettant à jour selon 
la date du jour et donc l’année en cours. 
 
Ces données ont été importées d’une base de données Access. Puisque ce document ne porte pas 
sur l’import de données externes, nous n’utiliserons que ces deux tableaux. 
 

 

Astuce 5 – Ajouter sauts de lignes dans une cellule avec CAR(10) ou 
ALT+ENTREE 

 
Le tableau Client contient les coordonnées de ces derniers. J’y ai ajouté une dernière colonne 
« Fiche » (colonne L). La formule utilisée est : 
 
=[@Société] & CAR(10) & CAR(10)  & [@Adresse] & CAR(10) & [@[Code postal]] & " " & [@Ville] & 
CAR(10) & [@Pays] 
 
CAR(10) permet d’aller à la ligne et le caractère & permet de concaténer. Ainsi dans la cellule nous 
aurons par exemple : 

 

Bonus : lorsque vous écrivez dans une cellule, pour aller à la ligne, tapez sur ALT+ENTREE. 
 

Drachenblut Delikatessen

Walserweg 21

52066 Aachen

Allemagne

http://www.cooking-excel.com/
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4.2. Le Tableau de bord 

 
Le document va vous permettre de réaliser le tableau de bord suivant, entièrement dynamique. En 
effet, les données vont s’actualiser en fonction des filtres via les segments mais également en 
fonction de la position du curseur (dans le tableau des clients). 
 
Ce tableau étant très riche, nous allons le décomposer en 4 parties, décrites ci-dessous. 

 
 

1. Graphe 1 : Liste des 10 clients avec Barre de défilement 
 

Cette première partie est une des plus compliquées. Sur la 
partie gauche, vous pouvez voir une barre de défilement. 
Ainsi, nous pouvons faire défiler les clients et les valeurs 
correspondantes en ayant toujours 10 clients affichés. 
 

Sur la partie haute, vous pouvez y découvrir deux flèches : 

 Permet de se positionner sur le premier élément de la liste ; 

 Permet de se positionner sur le dernier élément, qui contient le total général. 
 
 La liste des vendeurs est affichée sous forme d’onglet à droite des flèches. En sélectionnant un ou 
plusieurs vendeurs (en maintenant la touche CTRL), toutes les valeurs du tableau de bord se mettent 
à jour en fonction de ce filtre. 
Sur la partie centrale, la liste des clients avec Société, Pays, Ville et Chiffre d’affaire.  
Enfin sur la droite, la fiche client en fonction de celle sélectionnée (en positionnant le curseur tout 
simplement). Ci-dessous, nous avons le Total général et comme il n’y a pas de fiche client, nous en 
profitons pour afficher le nombre de clients distincts et le chiffre d’affaire correspondant aux filtres. 
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2. Graphe 2 : Evolution du Chiffre d’affaire 
 

Il est toujours intéressant de voir l’évolution dans le 
temps. La particularité ici est de comparer l’année en 
cours avec l’année précédente. Aussi, nous affichons 
la croissance entre les deux courbes (le pourcentage 
est affiché précisément entre les 2 courbes). 

 

 
  

3. Pilotage par segments 
 

Un tableau de bord qui ne serait pas dynamique resterait 
limité. Toutefois cela peut être un besoin pour une 
présentation par exemple. Nous verrons donc ici comment 
utiliser un segment chronologique ainsi que des segments 
imbriqués (hiérarchie, comme les pays et les villes). Nos 

segments piloteront l’ensemble des graphiques que nous avons pu voir jusqu’alors.  
 

 
 

4. Principaux indicateurs 
 

Enfin, il est très important pour un tableau de bord d’avoir quelques 
chiffres « références ». Ici nous aurons le chiffre d’affaire ainsi que 
l’affichage du client sélectionné. 
 

  

http://www.cooking-excel.com/


www.cooking-excel.com           15 

5. Graphe 1 : Liste des 10 clients avec barre de défilement 
 
Le graphique ci-dessous est totalement dynamique, que ce soit au niveau de la barre de défilement 
ou au niveau des onglets des vendeurs. 

 
 

 
Astuce 6 – Enregistrer au format xlsm 

 
Avant toute chose, enregistrez régulièrement votre fichier pour éviter de perdre votre travail. 
Attention, nous allons ajouter des petites macros en VBA dans le fichier. De ce fait, il est nécessaire 
d’enregistrer au format XLSM. 
 

 
 

5.1. Barre de défilement  

 

Difficulté :   

Ingrédients : Onglet Développeur, Barre de défilement, Champ nommé 

Durée : 5 min. 

 
La toute première étape consiste à ajouter deux nouvelles feuilles à votre classeur : 

- Travail : onglet de travail dans laquelle nous mettrons des calculs ; 
- TDB (Pour Tableau de bord) : contient le résultat final 

 

 
 
Allez ensuite sur l’onglet TDB, nous allons créer notre barre de défilement. 
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Astuce 7 – Afficher l’onglet développeur 

 
Vous avez besoin d’utiliser l’onglet développeur. Si vous ne le voyez pas, il va falloir l’afficher. 
RUBAN : Fichier > Options > Personnaliser le ruban 

 

 
 
Cochez la case « Développeur » comme sur la figure ci-dessus. 

 

 
Astuce 8 – Créer une barre de défilement 

 
RUBAN : Développeur > Contrôles > Insérer > Barre de défilement 

 

 
 
Positionnez ensuite la barre de défilement (Feuille : TDB, Plage : A19:A30) avec une hauteur 
d’environ 11 lignes. 

http://www.cooking-excel.com/
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Remarque : Pour sélectionner l’objet, utilisez le bouton droit de la souris ! 
 
Sélectionnez votre barre et cliquez sur le bouton droit de la souris puis choisissez Format de 
contrôle. 

 
 
Sous l’onglet « Contrôle », modifiez les valeurs telles que présentées ci-dessous. 
 

 
 
Les valeurs minimales et maximales définissent la taille de la barre. Ici les valeurs pourront aller de 1 
à 100.  
Le changement de page correspond au nombre de valeurs qu’on saute en cliquant sur Page Suivante 
ou Page précédente.  
 

 
 
 
Comme nous aurons 10 clients, la valeur 10 est parfaite. Toutefois si vous souhaitez que la dernière 
valeur devienne la première en cliquant sur Page suivante, mettez la valeur 9. 

http://www.cooking-excel.com/
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Enfin la cellule liée est sans doute la plus importante car elle nous permet de récupérer la valeur du 
numéro de la liste allant de 1 à 100. 
Nous mettrons la valeur dans la cellule A19. Tout à la fin, nous masquerons cette valeur en 
changeant la couleur de la police en blanc. 
 
Vous pouvez dès à présent vous amusez à cliquer sur la barre de défilement. Vous verrez ainsi la 
cellule A19 varier. 
 

 
Astuce 9 – Nommer une cellule (Champs nommé) 

 
Afin de réutiliser cette valeur facilement, nous allons la nommer : NumListe. 
(Feuille : TDB, Cellule : A19)  
Au-dessus de la colonne A, saisissez NumListe dans la case comme ci-dessous : 
 

 
 
Puis faites ENTREE. 
Vous venez de nommer votre cellule que nous réutiliserons ultérieurement. 
 

5.2. Faire défiler les clients  

 

Difficulté :   

Ingrédients : Tableaux Croisés Dynamiques (TCD), RECHERCHEV, SIERREUR, SI, INDIRECT, 

ADRESSE, LIGNE 

Durée : 25 minutes 

 
Cette partie étant la plus compliquée, n’hésitez pas à la refaire pas à pas pour bien  la comprendre.  
 
La première étape consiste à afficher les titres. Jusqu’ici, ce n’est pas compliqué mais cela permet de 
voir où vont être ensuite toutes les valeurs. 
 
Comme ci-dessous, entrez les titres à partir de la cellule B19. 
(Feuille : TDB, Plage : B19:G19) 
 

http://www.cooking-excel.com/
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Il y a une cellule vide après le CA (Chiffre d’affaire) car nous afficherons un petit graphique du CA 
dans la colonne E et le CA dans la colonne F. 
La colonne G contient le code client qui sera donc la clé de chaque ligne. Nous allons commencer par 
créer la colonne contenant ce code. 
 

 
Astuce 10 – Création du premier TCD 

 
Nous allons tout d’abord créer un Tableau croisé dynamique (TCD) des clients. Le but est de pouvoir 
piloter les données avec des segments. 
 
Allez sur la feuille « Factures » et créez un TCD. 
(Feuille : Factures, Cellule : A1) 
 
RUBAN : Insertion > Tableaux > Tableau croisé dynamique 
 

 

Modifiez l’emplacement afin de créer le TCD 
dans la feuille « Travail » : 
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Puis faites glisser vos champs dans LIGNES et ∑ VALEURS comme ci-dessous : 
 

 
 
Afin d’avoir le même type de contenu que notre tableau, nous allons devoir faire quelques 
modifications de mise en page de notre Tableau croisé dynamique (TCD). 
 
(Feuille : Travail, Cellule : A1) 
 
RUBAN : Outils de tableau croisé dynamique > Création > Disposition > Disposition du rapport > 
Afficher sous forme tabulaire 
 

 

 

 
RUBAN : Outils de tableau croisé dynamique > Création > Disposition > Sous-totaux > Ne pas 
afficher les sous-totaux 
 

 

 

 
Dernière petite modification, changeons le titre de la colonne E en modifiant directement la cellule 
E1 : 

http://www.cooking-excel.com/
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 Avant : Somme de PrixTotal 

 Après : CA 
 

 
 
(Feuille : Travail, Cellule : A1) 
 
Et n’oubliez pas de donner un nom à votre TCD ; cela sera plus pratique lorsque vous vous y 
réfèrerez. 
 
RUBAN : Outils de tableau croisé dynamique > Analyse > Options du tableau croisé dynamique 
 

 
 

 
Astuce 11 – Création de la colonne Code (avec barre de défilement) 

 
A présent, nous avons tous les éléments pour construire notre colonne. 
 
Logique : Dans la feuille TDB, cellule G20, je veux afficher le contenu de la cellule A2 de la feuille 
Travail, c’est-à-dire le code client. 
 

 
 
Pour faire référence à une cellule d’une autre feuille, on écrit le nom de la feuille suivi d’un point 
d’exclamation et de l’adresse de la cellule. 
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Exemple : Le premier client étant dans la cellule A2 de la feuille Travail, nous écririons : Travail!A2 
dans la feuille TDB. 
 
Notre objectif est d’afficher le client suivant (Feuille : TDB, Cellule : G20) à chaque fois que je vais 
cliquer vers le bas dans la barre de défilement.  
 

 
 
Note : Dans la feuille « TDB », quand NumListe (cellule A19) est égal à 1, la cellule G20 doit contenir 
l’information de la feuille « Travail », cellule A2 (Colonne A, Ligne 2).  
 
Nous comprenons donc que le client N se trouve sur la ligne N+1 de la feuille Travail. 
 
Pour automatiser les différents cas, Excel propose la fonction ADRESSE. 
 
ADRESSE renvoie l’adresse d’une cellule en fonction de son numéro de ligne, son numéro de colonne 
et le nom de sa feuille (exemple : Travail!A2) 
La fonction a la forme suivante : 
=ADRESSE ( No Ligne ; No Colonne ; [No Abs] ; [a1] ; [Nom de la feuille] ) 
 
Les arguments [No Abs] et [a1] sont optionnels et ne seront pas utilisés dans notre cas. 
 
La formule pourrait donc être (Feuille : TDB, Cellule : G20) 
= ADRESSE ( NumListe + 1 ; 1 ; ; ; "Travail") 
= ADRESSE (numéro de ligne qui dépend du numéro de client + 1 ; Colonne A ; ; ; Feuille Travail). 
 
 
Nous allons ensuite devoir recopier cette cellule de G21 à G30 dans la feuille « TDB ».  
Toutefois, nous devons récupérer le numéro de client suivant à chaque nouvelle ligne. 
Nous aurions par exemple : 
 
(Feuille : TDB, Cellule : G21) : = ADRESSE ( NumListe + 2 ; 1 ; ; ; "Travail") 
(Feuille : TDB, Cellule : G22) : = ADRESSE ( NumListe + 3 ; 1 ; ; ; "Travail") 
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… 
(Feuille : TDB, Cellule : G30) : = ADRESSE ( NumListe + 11 ; 1 ; ; ; "Travail") 
 
 

 
Astuce 12 – Ajouter le bon nombre de lignes avec LIGNE()-LIGNE(<cellule>) 

 
Il faut donc ajouter 1 à chaque ligne. Mais pour éviter de modifier à chaque fois, voici une petite 
astuce. 
Il faut faire la différence entre la ligne sur laquelle est la formule et la ligne d’entête du tableau. 
Par exemple : 
 

Cellule Cible (G20 à G30) Cellule Entête (G19)  

Ligne Ligne Différence entre les 2 lignes 

20 19 1  

21 19 2 

22 19 3 

… 19 … 

30 19 11 

 
Nous voyons que la colonne « Différence » répond à notre besoin : NumListe + Différence. 
 
La fonction LIGNE permet de retourner le numéro de ligne de la cellule. Elle se présente sous la 
forme suivante : 
= LIGNE ( [cellule] ) 
 
Si aucune [cellule] n’est renseignée, la fonction renvoie le numéro de la ligne dans laquelle elle se 
trouve. 
Par exemple : Si en cellule A67, je tape la formule suivante :  
= LIGNE() 
Alors la fonction retournera la valeur 67. 
 
Nous pouvons donc faire évoluer notre formule ainsi : 
= ADRESSE ( NumListe + LIGNE() – LIGNE($G$19) ; 1 ; ; ; "Travail") 
= ADRESSE ( NumListe + Ligne de la cellule cible – Ligne de la cellule entête ; 1 ; ; ; "Travail") 
 
Exemple pour la cellule G20, si NumListe est égal à 1 (premier client) nous aurons : 
= ADRESSE ( 1 + 20 – 19 ; 1 ; ; ; "Travail") 
= ADRESSE ( 2 ; 1 ; ; ; "Travail") 
Le résultat sera : Travail!A2 
 
 
 
 
 
Récupérons le contenu de l’adresse 
Nous avons donc bien récupéré la cellule à ramener. Mais nous souhaitons récupérer le contenu et 
non l’adresse de la cellule. Pour cela, nous utiliserons la fonction INDIRECT. 
 
=INDIRECT(ADRESSE(NumListe+LIGNE()-LIGNE($G$19);1;;;"Travail")) 
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A présent, recopiez cette cellule de G20 à G30. 
Pour tester, déplacer votre Barre de défilement en la déplaçant à gauche de votre nouveau tableau : 

 
 
Vous pouvez désormais jouer avec votre barre de défilement et vous constaterez le résultat sur la 
colonne Code. 
 

 
Astuce 13 – Remplir les colonnes avec RECHERCHEV 

 
Nous avons notre clé, il suffit à présent de récupérer la société, le pays, la ville et le chiffre d’affaire 
que nous avons dans notre tableau croisé dynamique (TCD) sur l’onglet Travail. 
 
Nous avons deux méthodes pour récupérer ces valeurs : 

 Le fonction RECHERCHEV 

 Les fonctions INDEX / EQUIV 
 
Nous choisirons la première dans notre cas qui est largement suffisant et beaucoup plus simple. 
En cellule B19 entrer la formule suivante :  
=RECHERCHEV(G20;Travail!$A:$E;2;FAUX) 
 
La fonction recherche « ALFKI » (cellule G20) dans la colonne Travail!$A et ramène la valeur de la 
2ème colonne du tableau comprenant les colonnes A à E de la feuille Travail. 

 
 
Le problème est que si vous voulez recopier les mêmes formules sur la droite, vous êtes obligé de les 
modifier. Je vous l’accorde, les modifications sont minimes : 
 
Pays : =RECHERCHEV(G20;Travail!$A:$E;3;FAUX) 
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Ville : =RECHERCHEV(G20;Travail!$A:$E;4;FAUX) 
CA : =RECHERCHEV(G20;Travail!$A:$E;5;FAUX) 
Voici le résultat : 

 
 
 

 
Astuce 14 – Trier les lignes par CA décroissant dans un TCD 

 
Vous voyez qu’il est difficile de trier directement notre tableau. Mais n’oubliez pas que nous nous 
sommes basés sur le tableau croisé dynamique TCD_Clients de l’onglet travail. Il suffit donc de trier 
ce TCD pour trier notre tableau. 
 

 
 
 
 
 
Puis 
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Et voici le résultat sur votre onglet TDB : 

 
 
Si nous descendons jusqu’en bas, nous tomberons sur des lignes particulières : 

 
 
Nous trouvons des erreurs car le code vide n’existe pas. 
Aussi, la dernière ligne du TCD est Total général. Nous pouvons le voir dans la colonne Code. Pour 
une meilleure lisibilité, nous allons le recopier dans la colonne B. 
 
Pour le premier point, nous allons ajouter la fonction SIERREUR. Ecrivez en cellule $B$20: 
=SIERREUR(RECHERCHEV(G20;Travail!$A:$E;2;FAUX);0)  
 
Pour le second point, toujours en $B$20 (remplacez la formule précédente) : 
=SI(G20="Total général";"Total général";SIERREUR(RECHERCHEV(G20;Travail!$A:$E;2;FAUX);0)) 
 
Ensuite recopiez jusqu’en bas. 
 

 
Astuce 15 – Masquer les zéros 

 
De nombreux zéros apparaissent mais vous ne souhaitez pas les afficher sur cette feuille. Voici une 
petite astuce pour ne plus être embêté avec ces zéros. 
 
RUBAN :  
Fichier > Options > Options avancées > Options d’affichage de la feuille de calcul 
 
Et décochez « Afficher un zéro dans les cellules qui ont une valeur nulle » 
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REMARQUE : il faut auparavant que le format ne soit pas un format personnalisé. Faites CTRL + 
SHIFT + 1 puis choisissez un format Standard. 

 

5.3. Ajouter barre de données pour Chiffre d’affaire 

 

Difficulté :   

Ingrédients : Mise en forme conditionnelle, Format de cellule 

Durée : 5 minutes 

 
La partie complexe est maintenant derrière nous. Cette petite étape va être rapide à mettre en 
œuvre ! 
Nous allons d’abord recopier les valeurs de la colonne F dans la colonne E en utilisant la formule 
suivante en E20 : =F20 
Que nous allons recopier jusqu’en E30. 

 

 

 
Astuce 16 – Recopier rapidement les formules 
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Pour gagner du temps et éviter de recopier les formats, voici un petit combo dont j’use et abuse ! 
 
Sélectionner la plage complète (ou vous souhaitez recopier les formules) 
Tapez F2 
Puis CTRL + ENTREE 
 
Vous venez de recopier les formules uniquement avec quelques raccourcis. Avec la pratique, le gain 
de temps est assez énorme. 
 

 
Astuce 17 – Afficher des barres de données 

 
Sélectionnez les cellules E20:E30 

 
 
Allez dans mise en forme conditionnelle et ajouter tout simplement la barre de données. 
 
RUBAN : Accueil > Style > Mise en forme conditionnelle > Barre de données 

 
 
Vous devriez avoir ce résultat : 
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Astuce 18 – Changer le format rendre la valeur invisible 

 
La colonne montre les montants. Or, nous l’avons déjà en colonne F et nous souhaitons garder 
uniquement les barres de données. 
On pourrait changer la couleur de la police, en mettant en blanc mais sur l’orange, ce serait visible. 
Alors quoi faire ? 
Voici une astuce qui vous sera fort utile : 
 
Sélectionnez les cellules E20:E30  
Faites CTRL+SHIFT+1 (ou bouton droit, format de cellule)  
Dans l’onglet nombre, choisissez la catégorie personnalisée  
Et tapez ; dans Type. 
 

 
 
Voilà, plus rien n’apparaît. En fait avec le point-virgule, vous avez dit que lorsque le nombre est 
positif, utilisez le format RIEN ! Du coup, cela ne se voit plus ! 
 
Voici le résultat : 
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5.4. Colorier la ligne sur laquelle est le curseur 

 

Difficulté :   

Ingrédients : Mise en forme conditionnelle, LIGNE, CELLULE, MIN, MAX, VBA (Calculate) 

Durée : 15 minutes 

 
Nous allons le faire en 3 étapes : 

1. Ecrire dans une cellule la ligne dans laquelle nous sommes ajoutant des bornes inférieures et 
extérieures. 

2. Actualiser cette cellule avec une macro VBA (Langage utilisé dans la suite Office) 
3. Ajouter une mise en forme conditionnelle 

 
 
 

 
Astuce 19 – Connaître le numéro de ligne d’une cellule 

 
Je vous ai présenté la fonction LIGNE() qui renvoie le numéro de la ligne de la cellule dans laquelle 
est la fonction. Quelle phrase compliquée ! 
Pour connaître la ligne de la cellule active, nous allons utiliser la fonction CELLULE. 
 
Voici un comparatif des deux fonctions pour bien comprendre : 
Les formules sont en A1 et B1 tandis que je suis en A4. 
=LIGNE() renverra 1 la cellule où est la formule. 
=CELLULE("ligne") renverra 4 (la cellule où je suis) 
 

 
 
La fonction CELLULE peut également retourner d’autres informations sur la cellule active, comme 
l’adresse, la colonne, le format… 

http://www.cooking-excel.com/


www.cooking-excel.com           31 

Amusez-vous pour voir les possibilités. A noter que vous pouvez ajouter un argument (facultatif) 
pour spécifier la cellule pour laquelle vous souhaitez l’information. 
 
Finalement, placez-vous en A20 et écrivez la cellule suivante : 
=CELLULE("ligne") 
 

 
Astuce 20 – Calcul de la feuille avec une Macro VBA (F9) 

 
Vous pouvez remarquer que lorsque vous vous déplacez, la valeur ne s’actualise pas.  
A présent, après chaque déplacement, tapez sur la touche F9 (permet de recalculer le classeur). La 
valeur est mise à jour. 
 
Vous avouerez que c’est assez pénible de devoir cliquer sur F9 après chaque déplacement. 
L’utilisateur ne le fera jamais. Nous allons donc automatiser cela avec une petite macro. N’ayez pas 
peur !!!! 
 
Puisque nous avons déjà affiché l’onglet développeur, nous n’avons pas à le refaire. 
La première étape consiste donc à ouvrir l’éditeur de Macro. 
 

 
 
 
Ou pour aller plus vite : 
 
ALT + F11 
 
Retenez bien ce raccourci, car à partir de maintenant, quand on dit Macro, on doit penser ALT+F11 ! 
 
Vous voici sur l’écran suivant : 
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Ne paniquez pas … enfin pas tout de suite !!! 
 
Cliquez deux fois sur Feuil5 (TDB) – cf. l’encadré en rouge ci-dessus. 
 
Puis choisissez Worksheet au niveau de la liste déroulante centrale (encadré vert ci-desssus). 

 
 
Vous voyez apparaître du code VBA : 

 
 
Il s’agit d’une fonction dite évènementielle : elle se déclenche à chaque fois que la sélection change, 
c’est-à-dire, à chaque fois que vous changerez de cellule. 
Il suffit ensuite d’écrire ce que nous souhaitons faire faire à cette MACRO, c’est-à-dire recalculer la 
feuille en utilisant la touche F9. 
 
Cela va être très compliqué comme vous pouvez le voir ci-dessous : 
 

 
Ajoutez Calculate entre les deux lignes. 
Votre macro est terminée. 
 
Fermez à présent votre éditeur VBA (avec la croix en haut à droite) et déplacez-vous sur votre feuille 
TDB. C’est magique, la valeur de la cellule $A$20 change toute seule et indique sur quelle ligne vous 
vous situez. 
 

 
 
 

 
Astuce 21 – Colorer une ligne 
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A présent, nous allons colorier la ligne sur laquelle nous sommes lorsque la cellule active est sur le 
tableau, c’est-à-dire entre $B$20 et $G$30, comme ci-dessous : 

 
 
Logique : 
Nous souhaitons mettre en jaune la ligne si celle-ci est égale à la ligne active.  
Dans notre cas ci-dessus, nous souhaitons avoir la première ligne (ligne 20) en jaune et seulement 
cette ligne. 
 
La formule devra donc être : 
=LIGNE($B20)=$A$20 
 
Nous ne mettons pas de $ devant le 20 ($B20) car la formule doit être B21 sur la seconde ligne, B22 
sur la troisième ligne, … 
 
A présent, ajoutons la mise en forme conditionnelle : 
RUBAN : Acceuil > Style > Mise en forme Conditionnelle > Nouvelle règle 
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A présent, déplacez-vous dans votre tableau : 

 
La ligne sélectionnée devient automatiquement jaune. 

 
Astuce 22 – Ajouter borne supérieure et inférieure 

 
Si vous vous déplacez sur la feuille, vous remarquerez que si la cellule se trouve au-dessus du tableau 
ou au-dessous, rien ne s’affiche. Le problème est que si vous souhaitez tout de même conserver le 
filtre du client, cela devient gênant. Il faudrait donc borner entre la ligne 20 et la ligne 30.  
Par exemple, si vous être sur la ligne 47, il faudrait que la ligne 30 soit en jaune. Si vous êtes sur la 
ligne 3, la ligne 20 doit être en jaune. 
 
L’astuce pour borner est toujours la même dans Excel. 
 
Etape 1 : Borner au-dessus 
Pour bien comprendre, nous allons créer plusieurs cas permettant de définir la règle. 
 

Cellule 
Active 

Ligne 
active 

Borne 
inférieure 

Ligne en 
jaune 

Règle 

A3 3 20 20 Maximum entre 3 et 20    20 
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A20   20 20 20 Maximum entre 20 et 20  20 

A25 25 20 25 Maximum entre 25 et 20  20 

A47 47 20 47 Maximum entre 47 et 20  20 

 
Nous en déduisons la formule suivante : 
=MAX(LIGNE(B20) ; CELLULE("ligne")) 
 
Avec LIGNE(B20) = 20, correspondant à notre borne inférieure ; 
Et CELLULE("ligne")) correspondant à la ligne active. 
 
Etape 2 : Borner au-dessous 
Refaisons le même cas que ci-dessus. 
 

Cellule 
Active 

Ligne 
active 

Borne 
Supérieure 

Ligne en 
jaune 

Règle 

A3 3 30 20 Minimum entre 3 et 30    3 

A20   20 30 20 Minimum entre 20 et 30    20 

A25 25 30 25 Minimum entre 25 et 30    25 

A47 47 30 47 Minimum entre 47 et 30    30 

 
Nous en déduisons la formule suivante : 
=MIN(LIGNE(B30) ; CELLULE("ligne")) 
 
Avec LIGNE(B30) = 30, correspondant à notre borne supérieure ; 
Et CELLULE("ligne")) correspondant à la ligne active. 
 
 
Etape 3 : Combiner les deux 
Pour cela il suffit donc d’imbriquer les deux formules : 
=MAX(LIGNE(B20) ; CELLULE("ligne")) 
=MIN(CELLULE("ligne") ; LIGNE(B30)) 
 
Ce qui donne : =MIN(MAX(LIGNE(B20);CELLULE("ligne"));LIGNE(B30)) 
 
Remplacez à présent votre formule CELLULE("ligne") en A20 par la nouvelle formule : 
=MIN(MAX(LIGNE(B20);CELLULE("ligne"));LIGNE(B30)) 
 
Déplacez-vous dans votre feuille et admirez !!! 
 

5.5. Modifier le format des montants 

 

Difficulté :   

Ingrédients : Format de nombre 

Durée : 5 minutes 

 

 
Astuce 23 – Mettre un montant en Euros 
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Sélectionnez votre colonne qui contient le chiffre d’affaire. 

 
 
RUBAN : Accueil > Nombre > choisir dans la liste déroulante 
 
Et choisissez ensuite Monétaire : 

 

 
 
Et voici le résultat : 

 
 

 
Supprimons à présent les chiffres après la virgules pour n’avoir que des nombres entiers. 
RUBAN : Accueil > Nombre > Réduire les décimales 
 

 
 
Cliquez deux fois sur le bouton pour enlever les deux décimales. 
 
Résultat : 
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5.6. Aller directement en première ou dernière ligne 

 

Difficulté :   

Ingrédients : Formes, NBVAL(), VBA (RANGE.VALUE, RANGE.SELECT) 

Durée : 10 minutes 

 
Nous alllons ajouter les deux flèches suivantes : 

 
 
La flèche bleue permettra de se positionner sur le premier client tandis que la flèche orange nous 
positionnera sur la dernière ligne, c’est-à-dire le Total général. 
 

 
Astuce 24 – Créer une flèche 

 
Le principe est le même pour chacune des flèches. Commençons par la flèche bleue. 
Tout d’abord, il faut donc créer la flèche : 
 
RUBAN : Insertion > Illustrations > Formes > Flèches pleines > Flèche vers le haut 
 
Puis créez votre flèche juste au-dessus du titre Société. 
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Choisissez ensuite la couleur souhaitée, après avoir sélectionné l’objet nouvellement créé. 
 
RUBAN : Outils de dessin > Format > Styles de formes > Choisir dans la liste déroulante 
 
 

 
Astuce 25 – Assigner une macro à un objet 

Cliquez sur la flèche avec le bouton droit puis Affecter une macro. 

 
Nommez votre macro : PremierElement 
Et cliquez sur Nouvelle.  
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L’éditeur VBA s’ouvre alors avec la macro prête à être écrite. 
 

 
Astuce 26 – Utiliser un champ nommé dans une Macro 

 
Entre Sub … et End Sub, tapez les commandes suivantes : 
    Range("NumListe") = 1 
    Range("B20").Select 
Comme sur l’écran ci-dessous : 
 

 
 
 
Quelques explications : 
Vous venez de créer une Macro (nommée PremierElement) dans un nouveau module nommé 
« Module1 ». 
Un module est un objet dans lequel nous pouvons créer plusieurs macros en VBA.. 
Cette macro est rattachée à l’objet FLECHE VERS LE HAUT que vous venez de créer (rappelez-vous le 
bouton « Affecter un macro »). A chaque fois que vous cliquerez sur la flèche, le contenu de 
PremierElement sera exécuté. 
 
Cette macro exécute deux instructions : 
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1. Range("NumListe") = 1 
2. Range("B20").Select 

 
La première permet de mettre la valeur 1 (= 1) dans la cellule (RANGE) nommé NumListe. Autrement 
dit, la valeur du champ nommé devient 1.  
Comme ce champ nommé est lié à la barre de défilement, nous allons affecter le premier élément à 
notre liste.  
 
La seconde instruction permet de sélectionner (SELECT) la cellule (RANGE) B20. Autrement dit, notre 
curseur est directement positionné sur la cellule B20, la première cellule de notre liste : 
 

 
 
Fermez à présent votre éditeur VBA et testez en cliquant sur la flèche. 
Flèche vers le bas 
Maintenant, nous allons refaire quasiment la même chose avec la flèche rouge. 
 

 
Astuce 27 – Compter le nombre d’éléments d’une liste 

 
Avant cela, nous allons créer un nouveau champ nommé DerniereLigne contenant le dernier élément 
de la liste puisque le but est de positionner la cellule sur le dernier élément. 
 
Nous allons compter le nombre de cellules de la liste qui se trouvent dans la colonne A de l’onglet 
Travail avec la formule suivante : 
 
Positionnez-vous en $A2$1 et tapez la formule suivante : 
=NBVAL(Travail!$A:$A) 
 
Le résultat est 91. Or, si vous comptez le nombre de clients, vous en trouvez 89 auxquels on peut 
ajouter la ligne du Total général, ce qui fait 90. 
En effet, la formule compte 1 pour la cellule A1 (le titre Code Client). Du coup, il faut enlever 1 à la 
formule initiale et cette dernière devient : 
 
=NBVAL(Travail!$A:$A) - 1 
 
 
 
Et nommez la cellule : 
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A présent, vous pouvez : 

- Créer votre flèche 
- Affecter une macro 
- La nommer: DernierElement. 

 

 
Astuce 28 – Avoir deux flèches de même taille en sens inverse 

 

 
 
Nous avons deux solutions pour réaliser cette manipulation. 
 
Solution 1 : 

1. Sélectionnez la flèche Bleue 
2. Notez la taille de la flèche 
RUBAN : Outils de dessin > Format > Taille 

 
3. Sélectionnez la nouvelle flèche 
4. Mettez à jour la taille avec les mêmes valeurs que celle de la première flèche. 

 
Solution 2 : 

1. Sélectionnez la flèche bleue 
2. Faites un copier / coller 
3. Cliquer sur la flèche ronde au-dessus de votre nouvel objet : 

 
4. Modifiez la couleur comme vous le souhaitez 

RUBAN : Outils de dessin > Format > Styles de formes > Choisir dans la liste déroulante 
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5. Attention : la macro qui était assignée à la flèche d’origine l’est également à l’objet cible car 
nous avons fait un copier / coller. Il vous faudra donc changer cela comme nous avons vu lors 
de la création de la flèche vers le bas. 

 

 
Astuce 29 – Aligner des objets  

 
Nous souhaitons à présent que les deux flèches soient alignées en bas et en haut. Du coup, voici 
comment procéder en deux clics : 

1. Sélectionnez vos deux flèches (en maintenant la touche CTRL) 
2. Alignez ensuite en bas 

RUBAN : Outils de dessin > Format > Organiser > Aligner > Aligner en bas 
 

 
 

 
Astuce 30 – VBA: Donner une valeur à une cellule en fonction d’une autre 

 
Après avoir affecter une nouvelle macro (Astuce 25), entre Sub … et End Sub, tapez les commandes 
suivantes (rappel : pour afficher l’éditeur VBA, faire ALT + F11) : 
    Range("NumListe") = Range("DerniereLigne") - 10 
    Range("B30").Select 
 
Comme sur l’écran ci-dessous : 

 
 
Notez que les deux macros sont dans Module1. J’ai couper / coller la nouvelle macro pour avoir tout 
au même endroit. Ensuite, j’ai supprimé le Module2 (bouton droit puis Supprimer). 
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La première instruction (Range("NumListe") = Range("DerniereLigne") - 10) permet de mettre la 
valeur 80 (90 est le dernier élément - 10) dans la cellule (RANGE) nommé NumListe. Autrement dit, 
la valeur du champ nommé devient 80.  
Comme ce champ nommé est lié à la barre de défilement, nous allons affecter le 80ème élément en 
haut de notre liste (en B20). On enlève 10 car nous souhaitons afficher le dernier élément en cellule 
B30 et non en cellule B20. 
 
La seconde instruction permet de sélectionner (SELECT) la cellule (RANGE) B30. Autrement dit, notre 
curseur est directement positionné sur la cellule B30, la dernière cellule de notre liste : 
 

 
 
Vous pouvez fermer à présent l’éditeur VBA et testez le fonctionnement de vos deux flèches. 
 

5.7. Afficher la fiche client 

 

Difficulté :   

Ingrédients : Formes, TEXTE, CAR(10), &, LIREDONNEESTABCROISDYNAMIQUE, NBVAL, 

INDIRECT, ADRESSE, COLONNE, SI, SIERREUR 

Durée : 20 minutes 

Nous souhaitons créer une fiche client reprenant le nom de la société, l’adresse ainsi que le chiffre 
d’affaire si nous sommes sur un client. Si nous sommes sur le Total général, nous voulons afficher le 
nombre total de clients ainsi que le chiffre d’affaire total. 
 
Voici les deux exemples : 

 

 

 
 

 
Astuce 31 – Récupérer une valeur d’après un numéro de ligne 
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Pour retrouver l’adresse, le code postal et le pays qui se trouvent dans notre table TblClient (onglet 
Clients), nous avons besoin du Code Client. Mais comment trouver le Code Client si nous connaissons 
la ligne ? 
 
Nous connaissons déjà la ligne sur laquelle nous sommes positionnés dans la feuille TDB (Cellule 
A20). Le code client se trouve donc au croisement de la Colonne G (ou colonne 7) et de la ligne 
définie dans la cellule A20. 
 
La fonction permettant de retrouver l’adresse d’une cellule d’après le numéro de colonne et le 
numéro de ligne est la fonction ADRESSE (cf. Astuce 10). Et pour récupérer le contenu de cette 
adresse, nous utiliserons la fonction INDIRECT. 
 
Positionnez-vous en $A$22 et tapez la formule suivante : 
 
 =INDIRECT(ADRESSE(A20;7)) 
 
Toutefois, si nous décidons de déplacer notre Bloc complet lors de la mise en forme finale, il est fort 
probable que la colonne dans laquelle se trouve le Code Client ne soit plus 7. Afin d’éviter ce genre 
de problème, nous allons utiliser la fonction COLONNE, permettant de récupérer le numéro de 
colonne d’une cellule : 
 
=INDIRECT(ADRESSE(A20;COLONNE(G19))) 
 
Nous avons à présent le Code Client : 

 
 

 
Astuce 32 – Retrouver des informations en fonction d’une clé (RECHERCHEV) 

Nous pouvons commencer à créer le contenu de notre fiche client. Pour rappel, nous avions déjà 
créé une nouvelle colonne à notre tableau de Clients, nommée Fiche (Voir Astuce 5): 
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Dans l’étape précédente, nous avons récupéré le Code client ; nous allons donc chercher la fiche en 
fonction du code client grâce à la fonction RECHERCHEV. 
 
Nous allons RECHERCHER la valeur de la cellule $A$22 dans le tableau TblClients (de l’onglet Clients) 
et récupérer la valeur correspondante de la 12ème colonne (Colonne L). Dans la cellule $A$23, tapez la 
formule suivante : 
 
=RECHERCHEV($A$22;TblClients;12;FAUX) 
 
La dernière partie de la formule signifie que nous recherchons la valeur exacte et non une valeur 
proche. Il existe plusieurs fonctions RECHERCHEx mais la plus utilisée reste RECHERCHEV qui permet 
de faire une recherche Verticale.  
 

 
Astuce 33 – Concaténer les chaînes de caractères 

Ajoutons le Chiffre d’affaire pour obtenir le résultat attendu. Nous allons utilisée la même méthode 
que pour retrouver le Code Client (cf. Astuce 30) en utilisant la formule suivante : 
 
INDIRECT(ADRESSE(A20;COLONNE(F19))) 
 
Nous allons donc concatener les deux formules (celles de l’étape précédente et celle-ci) en utilisant 
les fonctions suivantes : 

- & pour concaténer (mettre bout à bout des chaînes de caractère) ; 
- CAR(10) : Saut à la ligne dans une cellule. 

Vous pouvez donc saisir la formule suivante dans la cellule  $A$23, en remplacement de la 
précédente formule : 
 
=RECHERCHEV($A$22;TblClients;12;FAUX) & CAR(10) & CAR(10) & "CA: " &   
INDIRECT(ADRESSE(A20;COLONNE(F19))) 
 
Pour le moment, difficile de voir le résultat : 
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Astuce 34 – Afficher un texte dans un objet d’après une cellule 

Créer votre fiche : 
RUBAN : Insertion > Formes > Rectangles > Rectangle 
 

 
 
Créer une forme assez grande comme ceci (en masquant la partie Code client qui n’est pas 
intéressante à afficher) : 

 
 
Gardez la sélection de votre rectangle et dans la barre de formule, tapez la formule suivante : 
=$A$23 

 
 
 
 
 
 
 
 
 
Et si on se positionne sur la toute dernière ligne, Total général ? 
 

http://www.cooking-excel.com/


www.cooking-excel.com           47 

 
 
Nous avons une erreur ! Nous devons donc rajouter cette partie. En effet, dans le cas du Total 
général, nous souhaitons afficher le nombre de clients et le chiffre d’affaire. 
Tout comme l’étape ci-dessus, nous allons concaténer plus chaînes de caractères. 
Veuillez saisir la formule suivante dans la cellule $A$24 : 
 
="Nombre Clients: " & NBVAL(Travail!A:A)-2 & CAR(10) & CAR(10) & 
"Chiffre d'affaire: " & LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$A$1) 
 
NBVAL(Travail!A:A)-2 : pour compter le nombre de valeurs dans la colonne A de l’onglet travail (nous 
enlevons 2 car nous ne comptons ni le titre, ni le total général). 
 
LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$A$1) : Cette fonction permet de lire le 
tableau croisé dynamique situé en A1 de l’onglet travail et renvoie la valeur PrixTotal. 
Vous n’avez pas besoin de connaître cette fonction. Il suffit de taper = dans une cellule et de 
séelctionner la cellule E91 de l’onglet Travail : 
 

 
 
Pour voir le résultat, tapez la formule suivante en $A$25 : 
 
=SI(A22="Total général"; $A$24; $A$23 ) 
 
Et n’oubliez de modifier la formule liée à l’objet : sélectionner le rectangle et dans la barre de 
formule, modifiez en mettant : 
=$A$25 
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Déplacez-vous dans la liste et regardez si tout s’affiche comme vous le souhaitez. 
 

 
Astuce 35 – Mettre en forme des montants avec la fonction TEXTE 

 
Vous avez sans doute remarqué en vous déplaçant que le format des nombres n’était pas optimal : 
 

 

 

 
Il faudrait modifier le format comme nous pouvons le faire avec le format de cellule. 
Pour cela, nous utiliserons la fonction TEXTE. 
 
En A23, tapez : 
 
=RECHERCHEV($A$22;TblClients;12;FAUX) & CAR(10) & CAR(10) & "CA: " & 
TEXTE(INDIRECT(ADRESSE(A20;COLONNE(F19)));"# ##0") 
 
En rouge apparaît le changement par rapport à la formule précédente. Le but est d’utiliser le format 
# ##0 qui permet d’afficher un espace pour les milliers. 
 
En A24 : 
 
="Nombre Clients: " & NBVAL(Travail!A:A)-2 & CAR(10) & CAR(10) & 
"Chiffre d'affaire: " & TEXTE(LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$A$1);"# ##0 "" 
K€""") 
 
En rouge apparaît le changement par rapport à la formule précédente. Le but est d’utiliser le format 
# ##0 " K€" qui permet d’afficher un espace pour les milliers et de transformer le format 
automatiquement en milliers d’euros.  
 
 
 
 
 
Voyons à présent le résultat : 
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Astuce 36 – Mettre en forme la fiche 

Nous allons finaliser en mettant en forme notre fiche afin qu’elle s’intègre parfaitement dans notre 
tableau. Sélectionnez le rectangle et suivez les étapes qui suivents : 
 
RUBAN : Accueil > Alignement > Aligner au centre 
RUBAN : Accueil > Alignement > Aligner à gauche 
 

 
 
RUBAN : Accueil > Police > Couleur de remplissage (Indigo, texte 2) 
RUBAN : Accueil > Police > Couleur de police (Blanc, Arrière-plan 1) 
RUBAN : Accueil > Police > Taille de police (10) 
 

 
 
RUBAN : Outils de dessin > Format > Styles de formes > Contour > Sans contour 
 

 
 
Enfin déplacez votre rectangle pas à pas avec CTRL + Flèche puis ajustez la taille : 
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RUBAN : Outils de dessin > Format > Taille  
 

 
 
Remarque : adaptez la hauteur à votre besoin. Pour certains, cela peut être légèrement différent de 
4,34. La remarque est la même pour la largeur. 
 
Mettons à jour le format du tableau 
Sélectionnez le tableau (B20:G30) 
 

 
 
Faites CTRL+SHIFT+1  
Et faites comme la copie d’écran ci-dessous : 
 

 
 
 
 
 
 
 

Couleur Lignes supérieure et inférieure Ligne centrale 
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Dernier point pour la mise en forme : masquer les formules de la colonne A. 
Sélectionnez la colonne A (en cliquant sur la lettre A) et modifier la couleur de la police : 
 
RUBAN : Accueil > Police > Couleur de police (Blanc, Arrière-plan 1) 
 

 
Astuce 37 – Supprimer le quadrillage 

Pour bien voir le résultat complet, l’idéal est de supprimer le quadrillage. 
 
RUBAN : Affichage > Afficher > Décocher Quadrillage 
 
Voici le résultat : 
 

 

5.8. Ajouter les onglets Vendeurs 

 

Difficulté :   

Ingrédients : Segments, TCD 

Durée : 10 minutes 

 
Nous arrivons à la dernière étape de notre premier graphique.  
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Astuce 38 – Créer un segment 

 
Pour créer nos onglets, nous allons tout d’abord commencer par créer un Segment (Slicer en anglais). 
Un segment est un filtre graphique. 
 
Allez sur votre onglet Travail, et positionnez votre curseur sur le tableau croisé dynamique des 
clients. 
RUBAN : Outils de tableau croisé dynamique > Analyse > Filtrer > Insérer un segment 
 

 
 
Et choisissez Prénom :  
 

 

Vous obtenez ceci : 

 

 
Coupez (CTRL + X) et copiez (CTRL + C) le segment sur votre onglet TDB. 
 
Amusez-vous avec le segment et regardez l’impact sur votre tableau. Pour cela, vous pouvez 
sélectiioonner le prénom désiré (par exemple Janet) et constater que le tableau se mettra à jour 
automatiquement. En effet, lorsque je choisis un prénom, le Tableau croisé dynamique TCD_Clients 
est mis à jour. Et comme les données de notre tableau « 10 clients » sont basées sur ce TCD, les 
informations sont automatiquement mises à jour. Nous avons donc filtrer selon le prénom. Le chiffre 
d’affaire est également mis à jour. 
Notez qu’il est possible de sélectionner plusieurs prénoms en maintenant la touche CTRL appuyée. 
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Astuce 39 – Transformer le segment en onglets 

 
Voici les étapes à réaliser pour y arriver : 

1. Supprimer l’encadrement 
2. Choisir les couleurs des onglets 
3. Affecter le nouveau style au segment 
4. Supprimer le titre du segment 
5. N’avoir qu’une seule ligne et redimensionner 
6. Positionner le segment 
7. Modifiez la hauteur de ligne 
8. Créer un rectangle pour la jointure du tableau au segment 
9. Enjoy ! 

 
Supprimer l’encadrement 
 
Sélectionnez le segment ; 
RUBAN : Outils Segment > Options > Styles de segments 
Choisissez ensuite le format souhaité : 
 

 
 
Faites bouton droit et cliquez sur Dupliquer : 
 

 
 
Donnez un nom à votre nouveau segment, puis choisissez Segment entier et cliquez sur Format. 
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Dans l’onglet Bordure, cliquez sur Aucune : 
 

 
 
Choisir les couleurs des onglets 
Choisissez ensuite « Sélectionné avec données » et cliquez sur format : 
 

 
 
Dans l’onglet Remplissage, choississez la couleur suivante : 
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Vous pouvez valider. 
 
Affecter le nouveau style au segment (celui que vous venez de créer) 
 

 
 
Voici le résultat pour le moment : 

 
 

Remarquez que les bordures autour de chaque prénom n’a pas été mis à jour. Vous pouvez 
également supprimer la bordure en modifiant de la façon suivante : 
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Puis 

 
 
Supprimer le titre du segment 
Bouton droit sur le segment puis Paramètres des segments : 

 

 
 
Décochez ensuite « Afficher en-tête » 
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N’avoir qu’une seule ligne et redimensionner 
L’astuce n’est pas de se dire qu’il faut qu’une seule ligne mais qu’il faut autant de colonne que de 
Prénoms. C’est-à-dire 9 colonnes. 
 
Séletionnez à nouveau votre segment. 
RUBAN : Outils Segment > Options > Boutons 
RUBAN : Outils Segment > Options > Taille 
 
Choisir 9 dans Colonnes et adaptez ensuite la taille du segments en le redimensionnant : 
 

 
 
Positionner le segment 
Augmentez la taille de la ligne 19. 
Sélectionnez la ligne, bouton droit, Hauteur de ligne et écrivez 15. 
 

 
 
Déplacer ensuite le segment ainsi : 

 
 
Créer un rectangle pour la jointure du tableau au segment 
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RUBAN : Insertion > Formes > Rectangles > Rectangle 
 
Créez le rectangle entre les titres et les onglets : 
 

 
 
Sélectionnez le rectangle et modifiez la couleur de remplissage et supprimer le contour. 
 

 

Remplissage : 

 

Contour : 

 

 
Voilà le résultat final : 

 
 
Essayez de modifier les onglets, de vous déplacer dans les clients, de sélectionner la dernière ligne. 
Voici un graphique totalement dynamique ! 
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6. Graphe 2 : Evolution du Chiffre d’affaire 
 
Ce graphique représente l’évolution du chiffre d’affaire de l’année N (année en cours) en 
comparaison à l’année n-1.  
Une des particularités concerne l’origine des données. En effet, nous souhaitons afficher l’évolution 
du client sélectionné dans le graphe1 (ou le Total général). Cela signifie qu’à chaque fois que nous 
allons déplacer le curseur, le graphique va s’adapter. 
Une autre particularité est l’affichage des écarts en pourcentage centré entre les deux courbes. 

 
 
Voici les étapes pour construire ce graphique : 

1. Réalisation du Tableau croisé dynamique ; 
2. Construction du tableau complet (source) 
3. Construction du tableau pour le graphique avec les deux années ; 
4. Calcul de l’écart ; 
5. Actualisation automatique du TCD à chaque mouvement ; 
6. Réalisation du graphique ; 
7. Calcul de la moyenne (pour avoir l’écart au milieu de 2 courbes). 

 

6.1. Réalisation du tableau croisé dynamique 

 

Difficulté :   

Ingrédients :  TCD 

Durée : 5 minutes 

 
Nous en avons déjà réalisé un plus tôt, je vais donc uniquement vous présenté les copies d’écran 
pour réaliser celui-ci pas à pas. 
Positionnez-vous sur l’onglet Factures, dans n’importe quelle cellule du tableau. 
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Créez votre TCD dans l’onglet Travail, cellule $N$1 de façon à laisser de la place pour construire 
ensuite notre tableau qui servira de base pour le graphique.  
 

 

Nommez votre tableau croisé dynamique : TCD_Evolution 
RUBAN : Outils de tableau croisé dynamique > Analyse > Options du tableau croisé dynamique. 
 

 

 
Astuce 40 – Insérer colonnes avec deux raccourcis 

Si vous ne savez pas combien de colonne laisser, vous pouvez très bien le faire en $G$1 puis vous 
insérerez des colonnes avec CTRL+ESPACE puis CTRL et + 
 

 
Astuce 41 – Impossible d’insérer une colonne 

Il peut arriver dans certains de ne pas pouvoir insérer une colonne. Dans la majorité des cas, cela est 
dû au fait que la dernière colonne de la feuille contient des données. Allez donc tout à droite 
(CTRL+Fin) et supprimer les colonnes en trop (CTRL+ESPACE puis CTRL+ -) 
 

 
Astuce 42 – Grouper les dates 

Si vous utilisez Office 2016, vous n’avez pas besoin de réaliser cette manipulation. 
 
Allez ensuite sur l’onglet Travail et construisez votre TCD en ajoutant tout d’abord 
« Date_Commande » dans Colonnes : 
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Positionnez-vous sur n’importe quelle date dans votre TCD. Avec le bouton droit de votre souris, 
choisissez l’option Grouper : 
 

 
 
Sélectionnez Mois et Années, puis OK. 
 

 
 
 
 

Votre « colonnes » Votre TCD  
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A présent, il y a les années et les mois. 

 
Remarquez que nous voyons clairement l’année mais le mois garde la valeur du champ, à savoir 
Date_Commande. Si nous avions choisi Jour, Mois, Année, nous aurions Année, mois et 
Date_Commande pour les jours. 
 
Avec Office 2016 uniquement 
 
Quand on déplace Date_Commande dans Colonnes, nous avons directement : 
 

 

 

 
Il nous faut donc enlever le Trimestre pour avoir ce dont nous avons besoin. Ensuite, il faut 
développer les années : 
 
Bouton droit sur Année : 

 
 
 
Finalisation du TCD 
Vous pouvez maintenant finaliser le TCD avec les éléments suivants : 

 
 

http://www.cooking-excel.com/


www.cooking-excel.com           63 

 
Astuce 43 – Afficher / Masquer la liste des champs 

La liste des champs est la partie que vous voyez sur la droite : 
 

 
 
Pour masquer : 

 
 
Pour Afficher : 

RUBAN : Outils de tableau croisé dynamique > Analyse > Afficher > Liste de champs 
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6.2. Construction du tableau complet (source)  

 

Difficulté :   

Ingrédients : SI, LIREDONNEESTABCROISDYNAMIQUE, F2, CTRL+ENTREE 

Durée : 20 minutes 

Pour notre graphique, nous avons d’abord besoin de créer un tableau intermédiaire car il peut 
arriver que dans notre TCD, il manque certains mois. C’est d’ailleurs le cas ici puisque je n’ai aucune 
valeur en mai 2015. 
 
La conséquence s’il manque une valeur est que dans ma courbe, il va y avoir un décalage puisqu’il 
manquera le mois de mai. 
 
Nous allons donc construire un tableau csur un nouvel onglet. Positionnez-vous sur l’onglet travail et 
cliquez sur le +. Une nouvelle feuille va être créée à droite de Travail. 
 

 
 

 
Astuce 44 – Déplacer une feuille 

Si vous souhaitez déplacer votre feuille, il suffit de la sélectionner, de maintenir le bouton gauche de 
la souris appuyé et de la faire glisser à l’endroit souhaité.  
 
 

 
Astuce 45 – Renommer une feuille 

Nous allons renommer notre feuille : Travail_Courbe 
Soit nous faisons bouton droit sur l’onglet, puis renommer : 
 

 

 

 
Soit vous cliquez deux fois sur l’onglet et vous pouvez renommer la feuille. 
 
 
Création du Tableau Intermédiaire 
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Titres 
Maintenant, préparons notre tableau intermédiaire. Sur les deux premières lignes, il nous faut les 
années et mois comme ceci : 

 
 
Voici les formules à écrire : 
 

 
 

 
 
Il suffit de créer les deux premières colonnes puis de recopier. 
 
Clients 
Ecrire la formule suivante dans la cellule $A$3 : 
=Travail !N4 
Cette formule récupère le premier client de notre TCD. 
 

 
 
Copiez cette formule jusqu’en ligne 202 (nous avons environ 90 clients mais peut-être le nombre va 
augmenter, du coup, on se laisse une marge jusqu’à 200 clients ainsi), en tirant sur la cellule : 
 

 

 
 
Récupérer les données 
Positionnez-vous en cellule $B$3, puis tapez = et allez sur l’onglet Travail, cliquez sur la cellule O4 et 
faites ENTREE. 
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Vous devriez avoir le formule suivante dans $B$3 : 
 
=LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$N$1;"Société";"Alfreds 
Futterkiste";"Date_Commande";1;"Années";2014) 
 

 
Astuce 46 – Lire les données d’un TCD dynamiquement 

 
Afin de réutiliser la formule sur tout notre tableau, nous allons modifier la fomule ci-dessus en 
fonction d’autres cellules : 
 
=LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$N$1;"Société";"Alfreds 
Futterkiste";"Date_Commande";1;"Années";2014) 
 
Nous pouvons identifier à travers les couleurs, les critères sur les 3 champs Clients, Mois 
(Date_Commande) et Année. 
Le mois est exprimé en numéro de mois. C’est pour cette raison que dans notre ligne 2, nous avons 
utilisé la numérotation des mois. 
 
Le client se trouve en cellules $A3, le mois en cellule B$2 et l’année en cellule B$1. 
Remaquez la position du $ dans ma description ci-dessus. Il signifie que ma valeur qui suit est fixe. 
Par exemple $A3 signifie que mes clients sont dans la colonne A, pour toutes les lignes. 
 
De ce constat, je peux modifier ma formule ainsi : 
=LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$N$1;"Société";$A3;"Date_Commande";
B$2;"Années";B$1). 
 
Toutefois, il ne faut pas oublier le cas du Total général qui est différent. 
Dans la cellule $B$3 de la feuille TRAVAIL_Courbe, tapez = puis dans l’onglet Travail, sélectionnez la 
cellule O93 de la feuille « Travail »: 
 

 
 
La formule obtenue est : 
=LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$N$1;"Date_Commande";1;"Années";20
14) 
 
Il s’agit de la même que la précédente mais sans prendre en compte le client (société). Nous pouvons 
donc remplacer de la même manière : 
=LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$N$1;"Date_Commande"; 
B$2;"Années"; B$1) 
 
Du coup, notre formule en $B$3 devient : 
 
=SIERREUR(SI($A3="Total général"; 
LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$N$1;"Date_Commande";B$2;"Années";B
$1) ; 

http://www.cooking-excel.com/


www.cooking-excel.com           67 

LIREDONNEESTABCROISDYNAMIQUE("PrixTotal";Travail!$N$1;"Société";$A3;"Date_Commande";B
$2;"Années";B$1)) ; "") 
 

 
Astuce 47 – Modifier un grand nombre de cellules d’un coup 

Maintenant nous souhaitons la recopier partout dans notre tableau. 
Etape 1 : Sélectionner la colonne Z 
Etape 2 : Cliquer sur CTRL+SHIFT+Flèche droite (pour sélectionner toutes les colonnes à droite de 
notre tableau). 
Etape 3 : positionnez le curseur de la souris sur un entête de colonne 

 
 
Etape 4 : Bouton droit dela souris puis Masquer 
 

 
 
Vous n’avez plus de colonnes sur la droite : 
 

 
 
 
 
 
 
Etape 5 : Positionnez-vous sur la cellule $B$3 et cliquer deux fois sur le coin en bas à droite de la 
cellule. 
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Etape 6 : Combo magique  
CTRL+C (pour copier) puis CTRL+SHIT+Flèche droite puis ENTREE 
 

Votre tableau est terminé : 

 

A chaque fois que vous actualiserez votre TCD (bouton droit puis Rafraîchir ou RUBAN : Données > 

Actualiser les données), ce tableau se mettra automatiquement à jour. Et vous pouvez voir que la 

colonne correspondant à Mai 2015 existe même si elle est vide. 

 

6.3. Construction du tableau pour le graphique avec les deux années 

 

Difficulté :   

Ingrédients : INDEX, EQUIV 

Durée : 10 minutes 

 
Pour avoir les deux courbes (une pour chaque année), nous avons besoin d’avoir la structure 
suivante : 

 
 

Cellule Formule Valeur 
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H1 Client : Client : 

J3 =Année 2015 

I3 =J3 – 1 2014 

H4 Janvier Janvier 

H5 à H15 Dérouler la formule en H4 jusqu’en H15 

 
Maintenant, nous allons remplir les données avec des formules. 
 
Le client 
Nous devons la calculer en fonction du numéro de ligne qui est sélectionné. 
Nous allons réutiliser l’Astuce 31. 
 
Allez sur l’onglet TDB, cellule A20 et nommez le champ : LigneSelectionnee 
 

 
 
Toujours sur l’onglet TDB, en cellule A26 (à la suite des autres), tapez la formule suivante : 
=INDIRECT(ADRESSE(LigneSelectionnee;COLONNE(B19))) 
 
Sur l’onglet Travail, vous pouvez à présent saisir en cellule $I$1 la formule suivante : 
 

 
 

 
Astuce 48 – Figer les volets 

 
Pour préparer l’étape suivante, nous allons avoir besoin de figer les volets. 
Allez sur l’onglet Travail_Courbe, puis sélectionnez toute la ligne 3. 
 

 
 
RUBAN : Affichage > Fenêtre > Figer les volets > Figer les volets 
 
Maintenant, si vous deccendez, les deux premières lignes restent toujours visibles : 
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Astuce 49 – Retrouver une valeur avec INDEX / EQUIV 

 
Nous allons récupérer en $I$5 le chiffre d’affaire de Quick-Stop pour février 2014. Je ne choisis pas 
janvier car la valeur est nulle et c’est toujours plus facile de ramener une valeur non nulle pour 
s’assurer que notre calcul est juste. 
Si nous observons notre tableau de l’onglet Travail_Courbe, cette valeur est en C64 : 
 

 
 
Alors quelle serait la règle pour la retrouver ? Il faut considérer notre feuille comme une bataille 
navale. Pour retrouver l’adresse, il faut trouver le numéro de ligne où se trouve le client (Quick-Stop) 
et la colonne correspondant au mois et à l’année. 
 
Pour réaliser cette recherche, nous allons utiliser les fonctions INDEX et EQUIV. 
 
Fonction INDEX : 
=INDEX( matrice ; numéro de ligne ; numéro de colonne). 
Donc il faudrait avoir : 
=INDEX( $A$1:$Y$202 ; 64 ; 3) 
 
Fonction EQUIV : 
Cette fonction permet de retrouver la première position d’une valeur que nous recherchons. 
=EQUIV( valeur cherchée ; Matrice ; 0)  
Le 0 signifie que nous cherchons la valeur exacte (comme le FAUX dans la fonction RECHERCHEV). 
 
Donc pour trouver la ligne, il faudrait : 
=EQUIV( $I$1 ; $A:$A ; 0) 
Où $A:$A correspond à la colonne A. 
 
Et pour trouver le colonne, il faudrait : 
=EQUIV( Numéro du mois ; $A2:$Y2 ; 0) 
 
Mais nous n’avons pas le numéro de mois. Qu’à cela ne tienne, nous allons le 
rajouter manuellement dans l’onglet Travail: 
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Notre formule devient alors : 
=EQUIV( $G5 ; $A2:$Y2 ; 0) 
$G5 correspondant au mois de février que nous cherchons. J’ai mis le $ devant la colonne G car nous 
rechercherons le mois toujours dans cette colonne. En revanche la ligne variera selon le mois. 
 
Essayons de combiner tout cela dans la cellule I5 (en n’oubliant de préciser les feuilles): 
=INDEX(Travail_Courbe!$A$1:$Y$202; EQUIV( $I$1; Travail_Courbe!$A:$A; 0); EQUIV( $G5; 
Travail_Courbe!$A$2:$Y$2; 0)) 
Voici le résultat : 

 
 
Il correspond parfaitement à ce que nous recherchions. Recopiez cette formule de I4 à I15.  
 

 
 

Pour 2015, il faut ajouter une petite modification car le premier mois de février que nous allons 
trouver sera en 2014. Mais si au résultat du numéro de colonne (pour 2014, c’est 3), nous ajoutons 
12 (pour les 12 mois de l’année), nous aurons la colonne 15, c’est-à-dire la colonne O : 
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C’est bien le résultat attendu. 
 
Dans l’onglet Travail, copiez la cellule $I$4 en $J$5. 
 

 
 
Modifier la formule comme ci-dessous : 
=INDEX(Travail_Courbe!$A$1:$Y$202; EQUIV( $I$1; Travail_Courbe!$A:$A; 0); EQUIV( $G4; 
Travail_Courbe!$A$2:$Y$2; 0)+12) 
Vous voyez à la fin, j’ai rajouté +12. 
Le résultat étant concluant :  
 

 
 
Nous allons donc recopier la formule dans J5 à J15 : 
 

 
 

Si vous allez sur l’onglet TDB, et que vous changez de client, vous verrez que toutes les valeurs seront 
automatiquement actualisées. 
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6.4. Calcul de l’écart 

 

Difficulté :   

Ingrédients : SIERREUR, Pourcentage 

Durée : 5 minutes 

 
L’écart va nous permettre d’afficher le pourcentage de croissance entre l’année n-& et l’année n. 
Dans la cellule L3, écrivez « Croissance » et dans L4, tapez la formule suivante : 
 
=SIERREUR((J4-I4)/I4;0) 
 
Il s’agit tout simplement du bon vieux produit en croix permettant de calculer le pourcentage de 
croissance : ( CA 2015 – CA 2014 ) / CA 2014 
 
Nous avons rajouté SIERREUR car si le CA 2014 est nul alors, on évitera ainsi la division par zéro ! 
 

 
 

 
Astuce 50 – Mettre au format % sans décimales 

 
Pour une meilleure lisibilité, mettons au format % sans décimales. 
Séelctionnez la plage à mettre à jour et cliquez sur CTRL+SHIFT+% 
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6.5. Actualisation automatique du TCD à chaque mouvement 

 

Difficulté :   

Ingrédients : VBA (RefreshAll) 

Durée : 5 minutes 

 

 
Astuce 51 – Actualiser tous les TCD par macro VBA 

 
Cette partie va nous permettre d’actualiser les données et donc d’avoir le graphique qui se met à 
jour. Ouvrez l’éditeur VBA (ALT+F11). Je pense que vous commencez à le connaître par cœur !  
Cliquez deux fois sur TDB 
 

 
 

Modifiez l’ancien code par le suivant : 
Faites CTRL+A puis Suppr. 
Copier le code ci-dessous (CTRL+C) puis collez-le (CTRL+V) 
 

Private Sub Worksheet_SelectionChange(ByVal Target As Range) 
     
    'On recalcule 
    Calculate 
    
    'On rafraichit tous les TCD 
    ActiveWorkbook.RefreshAll 
     
End Sub 

 
Une ligne qui commence par ‘ est un commentaire et apparaît en vert.  
La nouveauté apparaît en gras. En écrivant cette instruction, on rafraichit l’ensemble du classeur et 
en particulier tous les tableaux croisés dynamiques . 

 

6.6. Réalisation du graphique 

 

http://www.cooking-excel.com/


www.cooking-excel.com           75 

Difficulté :   

Ingrédients : Courbes 2D, options de graphiques (Couleurs, Etiquettes, Titre, Quadrillage, Axes, 

Légende, Mises en forme). 

Durée : 15 minutes 

Pour le moment, nous n’allons pas gérer l’étiquette des écarts dans le graphique. Nous le réaliserons 
dans l’étape suivante. Nous allons néanmoins réaliser tout le reste. 
 

 
Astuce 52 – Créer un graphique avec 2 courbes 

 
Sélectionnez la plage H3:J15 

 
 
RUBAN : Insertion > Graphiques > Graphiques recommandés 
 

 

Choisissez le premier proposé. Vous pourrez modifier par la suite : 

 

 

 

Et déplacez le graphique sur l’onglet TDB en faisant tout simplement COUPER (CTRL+X) / COLLER 
(CTRL+V). 
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Astuce 53 – Déplacer le légende 

 
Sélectionnez le graphique et cliquez sur le + à droite.  
Puis sélectionnez la flèche à droite de Légende et choisissez Haut. 
 

 
 
Puis déplacez la manuellement ainsi : 

 
 
 
 
 
 
 
 
 
 
 
Notez que la partie dédiée au graphique est assez basse, nous allons la remonter manullement. 
 
AVANT APRES 
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Astuce 54 – Modifier les couleur d’une série 

 
Positionnez-vous d’abord sur Total général en cliquant sur la flèche orange. 

 
Le but étant d’avoir deux courbes que nous pouvons sélectionner plus facilement. 
Dans un but d’homogénéité des couleurs, nous allons changer la courbe 2015 en orange. 
 
Sélectionnez le courbe bleue clair en cliquant dessus. 
 

 
 
 
 
 
RUBAN : Outils de graphique > Format > Styles de formes > Contour > Orange 
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Astuce 55 – Ajouter et mettre en forme étiquettes de données 

 
Ajouter les étiquettes de données pour la courbe orange : 
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Sélectionnez n’importe quelle étiquettes (elles seront toutes sélectionnées). 
 

 
 
RUBAN : Outils de graphique > Format > Styles de formes 
Choisir ensuite le orange comme ci-dessous : 
 

 

 

 
Les valeurs sont trop grosses, il faut donc diminuer la taille de la police. 
Sélectionnez à nouveau une des étiquettes. 
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Astuce 56 – Ajouter un titre dynamique 

 
Tout d’abord, nous allons supprimer le titre en cliquant dessus, puis en appuyat sur la touche Suppr. 
A présent, insérez un rectangle (attention, le graphique ne doit pas être sélectionné). 
RUBAN : Insertion > Illustrations > Formes > Rectangles > Rectangle 
 
Et créez le là où vous souhaitez voir afficher le Titre : 
 

 
 
Dans la barre de formule, tapez ensuite : 
=$A$26 
Pour rappel, la cellule $A$26 contient le libellé de la société.  
Ensuite mettez en forme : 
RUBAN : Accueil 

 
Pour la couleur de remplissage : Aucun remplissage. 
Pour la couleur de police :  
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RUBAN : Outils de dessin > Format > Styles de formes > Contour > Aucun 
 
Vous pouvez tester en déplaçant le curseur sur le tableau des clients et le graphique, y compris le 
titre, sera mis à jour. 
 

 
 

6.7. Calcul de la moyenne (pour avoir l’écart au milieu de 2 courbes) 

 

Difficulté :   

Ingrédients : MOYENNE 

Durée : 5 minutes 

L’objectif ici est de créer une courbe entre deux autres courbes sur laquelle nous ajouterons des 
valeurs (qui n’ont rien à voir avec la nouvelle courbe puisqu’on affichera les écarts en pourcentage). 
Cette nouvelle courbe sera exactement entre les deux autres. Pour cela, on va calculer la moyenne 
entre les deux autres courbes. 
 
 
 
 
 
 
 
 

 
Astuce 57 – Calculer la moyenne 

 
Revenez sur l’onglet Travail pour finaliser le tableau et complétez : 
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La formule à recopier dans la colonne K est la suivante : 
=MOYENNE(I4:J4) 
 

 
Astuce 58 – Ajouter une série graphique en 2 clics 

 
Sélectionnez le colonnes (sans le titre), comme sur l’image ci-dessus.  
Faites CTRL + C ; 
Allez sur l’onglet TDB ; 
Sélectionnez le graphique ; 
Faites CTRL + V. 

Excel est si simple !!! 

 
 
Une nouvelle courbe (verte) apparaît !! 
 

 
Astuce 59 – Ajouter des étiquettes de données externes 

 
Nous souhaitons voir apparaitre la croissance en pourcentage. 
Sélectionnez la courbe verte.  
 

Etape 1 
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Etape 2 Etape 3 Etape 4 

 

 

 

 
Etape 5 
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Et voici le résultat : 
 

 
 

 
Astuce 60 – Faire disparaître une courbe 

 
Il ne reste plus qu’à rendre la courbe invisible pour ne laisser que le pourcentage. 
Sélectionnez la courbe verte. 
RUBAN : Outils de graphique > Format > Styles de formes > Contour > Sans contour 
 
Pensez à sélectionnez la légende, cliquez sur Série 3 et sur le bouton Suppr. 
 

 
Astuce 61 – Supprimer le quadrillage d’un graphique 

 
Cliquez simplement sur le quadrillage et cliquez sur la touche Suppr. 
 

 

Vous pouvez tester les onglets des vendeurs, de vous déplacer sur le tableau, le graphique se mettra 
automatiquement à jour. 

  

http://www.cooking-excel.com/


www.cooking-excel.com           85 

7. Pilotage par les segments 
 
Nous nous sommes appuyé sur des tableaux croisés dynamiques pour créer nos deux graphiques. Et 
une des particularités est la possibilité d’utiliser des segments (slicers en anglais). Ces segments sont 
des filtres sur les données comme nous avions avant Excel 2010. Toutefois, ils sont beaucoup plus 
évolués puisqu’il s’agit de filtres visuels. Nous en avons déjà créé un dans le chapitre 5.8. 
 
Depuis la version Excel 2013, un nouveau type de segment est apparu : le segment chronologique. 
Dans ce chapitre, nous commencerons donc par créer ce type d’objet. Ensuite, nous verrons 
comment imbriquer deux segments classiques telle une hiérarchie. Enfin, nous les connecterons tous 
à l’ensemble de nos tableaux croisés dynamiques. 
 

7.1. Création du segment chronologique 

 

Difficulté :   

Ingrédients :  TCD, Segment chronologique 

Durée : 5 minutes 

 

 
Astuce 62 – Création d’un segment chronologique 

 
Allez sur l’onglet Travail et positionnez-vous sur n’importe quelle cellule du tableau croisé dynamique 
TCD_Clients. Par exemple, en cellule $A$1. 
L’objectif est d’avoir accès aux outils du tableau croisé dynamique du ruban : 
 

 
 
 
EXCEL 2013 
 

Créez à présent le segment (Uniquement à partir d’EXCEL 2013): 
RUBAN : Outils de tableau croisé dynamique > Analyse > Filtrer > Insérer une chronologie 
 
Une fenêtre s’ouvre avec tous les champs DATE de votre TCD. Ici, nous n’avons que le champ 
Date_Commande. Sélectionnez et cliquez sur OK. 
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Déplcez le segment sur l’onglet TDB (CTRL+X puis CTRL+V). 
 

 
Astuce 63 – Copier et couper fonctionnent mais pas Coller. Comment faire ? 

 
Il peut arriver que cela ne fonctionne pas. Lorsque vous arrivez sur l’onglet TDB, faites directement le 
CTRL+V sans déplacer votre cellule. Car si vous la déplacez, la macro va recalculer et donc vider le 
presse-papier (le CTRL+V devient impossibel car il n’y a plus rien à coller). 
 
Si vous avez besoni de déplacer des cellules, pour que cela fonctionne, sélectionnez la plage et 
déplacez la directement.  
Si vous avez besoin de recopier une formule, 

- Soit vous sélectionnez directement dans la barre de formule puis CTRL+C  
- Soit vous sélectionnez la plage, puis F2 puis CTRL+ENTREE. 

 
En dernier recours, vous ouvrez la macro (ALT+F11 puis sélectionnez la feuille TDB) et mettez une 
apostrophe devant CALCULATE afin de mettre l’instruction en commentaire. A la fin des 
manipulation, n’oubliez pas d’enlevez l’apostrophe pour supprimer le mode commentaire. 
 

 
Astuce 64 – Modifier le titre du segment 

 
A présent, nous avons notre segment chronologique dans l’onglet TDB : 
 

 
 
Mais le titre Date_Commande ne nous convient pas. Pourquoi ne pas mettre « Période » ? 
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Sélectionnez votre segment. 
RUBAN : Outils Chronologie > Options > Chronologie > Légende de la chronologie 
 
On en profite pour changer la couleur : 
RUBAN : Outils Chronologie > Options > Styles de chronologie 
 

  

 
 
En cliquant sur MOIS, vous pouvez changer le type de période. Amusez vous avec le segment pour 
voir l’impact sur votre tableau de bord. Remarquez que cela n’a pas d’impact sur le graphique 
évolution. C’est ce que nous souhaitons car la partie évolution permet de comparer deux années. Si 
nous filtrons sur les périodes, cela n’aura plus vraiment de sens. 
 

 
 
EXCEL 2010 
 

Allez sur l’onglet Travail, positionnez-vous en $A$1 (comme pour l’étape précédente). 
RUBAN : Outils de tableau croisé dynamique > Analyse > Filtrer > Insérer un segment 
 
Sélectionnez Année et Date_Commande puis cliquez sur OK. 
 

 

 

 
A présent, sélectionnez vos deux segments (avec la touche CTRL), puis déplacez les sur l’onglet TDB 
avec CTRL+X puis CTRL+V. 
 
Puis positionnez les comme l’image ci-dessous : 
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A présent, il faut les mettre en forme. 
 
Sélectionnez le Segment Année : 
RUBAN : Outils Segment > Options > Boutons 
RUBAN : Outils Segment > Options > Taille 
 

 
 
Sélectionnez à présent le Segment Date_Commande. 
Faites un click-droit puis Paramètres des segments 
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Modifiez la légende 
Avant : Date_Commande 
Après : Mois 

 

 
RUBAN : Outils Segment > Options > Boutons 
RUBAN : Outils Segment > Options > Taille 
 

 
 
 

 
 

7.2. Création de segments « hiérarchiques » 

 

Difficulté :   

Ingrédients :  TCD, Segments 

Durée : 10 minutes 

 
Nous allons faire quelque chose de similaire au segment sur les vendeurs mais cette fois-ci avec les 
Pays. Et nous ajouterons un segment sur les villes. De cette façon, en choississant un pays, seules les 
villes correspondant au pays seront sélectionnables. 
 
Créons tout d’abord les deux segments : Pays et Villes. 
 
Allez sur l’onglet Travail, positionnez-vous en $A$1 (comme pour l’étape précédente). 
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RUBAN : Outils de tableau croisé dynamique > Analyse > Filtrer > Insérer un segment 
Sélectionnez Ville et Pays puis cliquez sur OK. 
 

  
 
A présent, sélectionnez vos deux segments (avec la touche CTRL), puis déplacez les sur l’onglet TDB 
avec CTRL+X puis CTRL+V. 
 

 
 
 

 
Astuce 65 – Modifier l’ordre de objets 

 
Tel que nous avons fait, il va falloir changer l’ordre des deux segments de façon à voir Ville devant 
Pays. 
Sélectionnez votre segment Ville.  
Attention : Si les deux sont sélectionnés, il vous faut d’abord cliquer dans n’importe quelle cellule 
pour les désélectionner puis sélectionner le segment Ville. 
Cliquez ensuite sur le bouton droit de la souris et choississez mettre au premier plan. 
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Voilà, vous venez d’inverser l’ordre entre les deux segments : 
 

 
 
A présent, adaptez la taille des segments : 
 

 
 
Nous allons à présent mettre en forme le segment Pays comme nous l’avions fait pour les vendeurs. 
Sélectionnez Pays. 
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Changez ensuite le style pour prendre le même que celui des vendeurs : 
RUBAN : Outils Segment > Options > Styles de segments 
 

 
 
A présent, supprimons le titre en cliquant avec le bouton droit de la souris : 
 

 

 

 

 
Passons au segment Ville 
Agrandissez la segment vers le haut pour légèrement recouvrir le segment pays : 
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Nous voyons à présent les onglets apparaître.  
Modifiez à présent le nombre de colonnes du segment Ville. 
RUBAN : Outils de Segment > Options > Boutons > Colonnes 
 

 
 
Si vous souhaitez, vous pouvez changer la couleur des villes en dupliquant un segment existant. Mais 
pour ce tableau de bord, je vais le laisser tel quel : 
 

 
 
Sélectionnez un Pays, et vous verrez le segment des villes s’adapter, ainsi que le chiffre d’affaire des 
clients sur la gauche. En revanche, aucun impact sur l’évolution du CA. Mais ce coup-ci nous 
souhaitons que cela ait un impact. D’ailleurs, si vous sélectionnez un Vendeur, les deux courbes ne se 
mettront pas à jour non plus. Il faut pour cela connecter les segments à l’ensemble des TCD. 

 

 

7.3. Connexion des Segments aux TCD 

 

Difficulté :   
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Ingrédients :  TCD, Segments 

Durée : 5 minutes 

 

 
Astuce 66 – Connecter un segment à un TCD 

 
Pour connecter un segment à un TCD, il faut sélectionner chaque segment l’un aptrès l’autre. Alors 
commençons avec notre bon vieux segment Vendeur ! 
 
Dans l’onglet TDB, sélectionnez le segment Vendeur. 
 

 
 
Vous avez le choix :  

- Soit avec le bouton droit ; 
- Soit avec le ruban. 

Pour le segment Vendeur, nous utiliserons le bouton droit et pour les segments Pays et Ville, nous 
utiliserons le Ruban. 
 
Cliquez sur « Signaler les connexions » : 
 

 

Cochez bien les deux Tableaux croisés dynamique : 

 
 
Remarquez ici qu’il est facile de les identifier car nous leur avions donné 
un nom. Si nous ne l’avions pas fait, nous aurions vu : 
Tableau croisé dynamique 1 
Tableau croisé dynamique 2 
Dans notre cas, on les sélectionne tous mais il peut arriver que cela ne soit 
pas le cas ; d’où l’intérêt de donner un nom aux TCD. 

 
 
Passons aux segments Pays et ville.  
La méthode sera exactement la même pour les deux. 
Sélectionnez le segment Pays. 
RUBAN : Outils de Segment > Options > Segment > Signaler les connexions 
 
Sélectionnez les deux TCD comme pour le segment Vendeur. 
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Recommencez la manipulation avec l’onglet Ville. 
 
Vos Segments sont connectés et à présent, dès que vous filtrerez, l’impact sera visible sur la liste des 
clients mais également sur le graphique d’évolution du chiffre d’affaire. 
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8. Principaux indicateurs 
 

Il est essentiel dans un tableau de bord d’avoir deux ou trois données qui ressortent par rapport aux 

autres. Elles correspondent à des indicateurs-clé. 

8.1. Exemples 
Voici quelques exemples de tableaux de bord : 

J’ai entouré en rouge les données-clé. 

 

Exemple1 : 

 
Exemple2 : 
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Exemple 3 :

 

8.2. Nos données principales 

 
Pour notre tableau de bord, nous utiliserons 2 indicateurs clé : 

- Chiffre d’affaire global (dépendant des filtres) 
- Nom de la société ou Total général 

 

 
 

8.3. Construction des 2 indicateurs 
 

Difficulté :   

Ingrédients :  INDIRECT, ADRESSE, COLONNE, TEXTE, &, Formes 

Durée : 10 minutes 

 
Les deux indicateurs vont être très simple à créer puisque les manipulations que nous allons réalisées 
ont déjà été faites précédemment. 
 
Pour le Chiffre d’affaire 
Nous allons créer un objet Rectangle à bord arrondi auquel nous allons affecter la valeur d’une 
cellule qui contient le chiffre d’affaire au format K€. 
 
Nous allons commencer par récupérer la valeur du chiffre d’affaire qui se trouve dans la tableau des 
10 clients au niveau de la colonne F (ou E). 
 
Dans la cellule $C$1, écrivez la formule suivante : 
=INDIRECT(ADRESSE(A20;COLONNE(F19))) 
F19 est la cellule correspondant au titre de la colonne des chiffres d’affaire. 
 
Maintenant, nous allons la mettre en forme afin d’obtenir ceci : 
CA : 1 265 K€ 
 
Modifier la cellule $C$1 en écrivant la formule suivante : 
="CA: " & TEXTE(INDIRECT(ADRESSE(A20;COLONNE(F19)));"# ##0 "" K€""") 
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Je ne reviens pas sur les explications de cette formule que nous avons déjà vu dans le chapitre 5.7. 
 

 
 
Créons à présent l’objet Rectangle avec coins arrondis : 
RUBAN : Insertion > Illustrations > Formes > Rectangles > Rectangle à coins arrondis 
 

 
 
Sélectionnez le rectangle et dans la barre de formule, tapez la formule suivante : =$C$1 
 

  
 
Finalisons en mettant en forme : 
 
RUBAN : Outils de dessins > Format 
 

> Styles de formes > Taille 

 

  

 
 
 
 
 
RUBAN : Accueil 

> Police Alignement 
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Voici le résultat : 
 

 
 
Pour le deuxième indicateur, en fait nous l’avions déjà créé lorsque nous avons créé le graphique 
évolution : 
 

 
 
S’il n’apparaît pas, il faut modifier l’ordre des objets (Astuce 65). 
Sélectionnez l’objet et déplacez le pour le positionner comme vous les souhaitez : 
 

 
 
A présent, modifions le format. 
 

 
Astuce 67 – Modifier la forme d’un objet 

 
Modifions d’abord la forme :  
RUBAN : Outils de dessins > Format > Insérer des formes > Modifier la forme > Modifier la forme > 
Rectangles > Rectangles à coins arrondis 
 

 
 
Modifions à présent le format de l’objet. 
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RUBAN : Outils de dessins > Format 
 

> Styles de formes > Taille 

  

  

 
RUBAN : Accueil 

> Police Alignement 

 
 

 
Pour finaliser, nous allons mettre en blanc la cellule $C$1 en modifiant la police : 
 

 
 

 
Astuce 68 – Organisation de l’espace avec alignements 

 
Sélectionnez les objets comme ci-dessous : 

 
 
RUBAN : Outils de dessin > Format > Organiser > Aligner > Aligner en haut 
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RUBAN : Outils de dessin > Format > Organiser > Aligner > Aligner à gauche 
 
Déplacez ensuite légèrement l’objet bleu vers la gauche puis sélectionnez ainsi : 
 

 

RUBAN : Outils de dessin > Format > Organiser > Aligner > Aligner à droite 

Voici le résultat final : 
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9. Finalisation du Tableau de bord 
 

Difficulté :   

Ingrédients :  Quadrillage, En-Têtes, Enregistrer sous 

Durée : 5 minutes 

 
Nous allons à présent réaliser les derniers ajustements pour avoir un tableau de bord propre que 
nous pourrons partager. 
 

 
Astuce 69 – Supprimer le quadrillage 

 
RUBAN : Affichage > Afficher > décocher Quadrillage 
 
Avant Après 

  
 

 
Astuce 70 – Masquer n° de lignes et Lettres des colonnes 

 
RUBAN : Affichage > Afficher > décocher En-Têtes 
 
Avant Après 

  

 

 
Astuce 71 – Partager en lecture seule 

 
Il est possible d’enregistrer le fichier en Lecture seule. Pour modification, un mot de passe est exigé. 
Toutefois, l’utilsateur pourra enregistrer le fichier dans un aure dossier. 
Allez dans Fichier puis Enregistrer sous. 
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Cliquez sur Outils 
 

 
 
 
Choisissez Options générales Choisissez un mot de passe pour modification et cochez 

Lecture seule recommandée 

 

 
 
 
Confirmez le mot de passe : 
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Et cliquez sur Enregistrer : 

 
 
Lorsque vous ouvrez ensuite le classeur Excel, l’écran suivant apparaît : 
 

 
 
Soit vous saisissez le mot de passe et avez accès à la modification du fichier.  
Soit vous avez la possibilité de cliquer sur Lecture seule (car vous aviez coché Lecture seule 
recommandée). 
 
En cliquant sur ce bout, vous pouveze voir en haut du fichier : 
 

 
 
Et bien sûr, vous pouvez modifier les filtres et garder le dynamisme de l’ensemble du tableau de 
bord : 
 

 
 
 
 
Si vous essayez de modifier, vous aurez le message suivant 
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CONCLUSION 
 
Vous êtes arrivé au bout de ce tutorial et vous pouvez admirez le résultat de votre travail.  
 

 
 
La grande majorité des astuces que vous avez pu rencontrée sont des astuces que j’utilise au 
quotidien. Cela signifie que vous allez pouvoir les réutiliser. La liste complète est sur la page suivante. 
Alors maintenant que vous savez ce qu’il est possible de faire, n’hésitez pas à vous réferrez à ce petit 
guide pour retrouver comment faire pas à pas.  
Et si vous souhaitez d’autres astuces, ou télécharger directement des template (modèles) tout prêt, 
n’hésitez pas à visitez mon blog : 
 

www.cooking-excel.com 
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